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DFNEZFITLET,

FIE

RECTIMEMTELONI T 7 via AFY ORREEZEELET (KB B

HEFF T ONE 7 7 v a AEVORBEEELET KBHN) . W77 vy aAEUNC
OFIFREIZES< &, FrLne FRRESIRRD £77,

[OK] &7 U v 27 LT, [Configure Logging Flash Usage] ¥ 1 7 0 7R 7 A% L FET,

X277 AXUT0EME

ATy T
ATy T2

ATvT3

ATy T4
ATy TH

FIE

[Configuration] > [Device Management]| > [Logging] > [Syslog Server] DJIRIZEIRN L £ 9,
EXaT X T EAR—TNWICT D syslog P—NEBRIRL, [Edit) 27 Y v 7 LET,

[Edit Syslog Server] A 7 B V7R v 7 ANERINET,
[TCP]1 AT v arv R&Z w7 vr LET,

X7 nX S TIIUDP 2 A — LT RWD, Zo7r barzALL> LT
LT —=NREELET,

[Enable secure syslog with SSL/TLS] F = 7 Rv 7 A& 4L T, [OK] %27V v 7 LET,

(&) [Reference Identity] |2, syslog —/30 555 L7z iEI=EIZ %95 RFC 6125 2/ 1D
Frv I eAX—TNMITHBMID AT V=7 NEARITIRELET,

REDYVE |



nxyy |
. syslog & —/\I2%{59 % EMBLEM 2 =X syslog * vt — U DERL

ZRID AT V=7 MZOWTFELLIE, ZRID ORELZSRLTIZEW,

syslog Y —/\[Z3%1E9 % EMBLEM Fs X syslog * v £ — S DARL
syslog #—/3~D EMBLEM JE D syslog A v & — T %A T 2121%, ROFINEEZFEITLET,

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Syslog Server] DJIEIZER L £ 9,
ATwT2 [Add) %7 U v 27 LT, #H L syslog V— " ZBIMLET,
[Add Syslog Server] ¥4 7 2 VR v 7 ANFERINET,
GE) 120X aVT7 4 ar7FA ML TRETE D syslog h—"OEIIH{ZKR TS T
T (GETI6ET)

ATV T3 syslogh— P EV—REOLE, ASATHF 2 —|ANDIZENTEDLA v E—UHERTEL
FT, ERErOREEIE, Fa—IlANLND A vy =P ERIRICZRY £,

AT 74 [Allow user traffic to pass when TCP syslog server is down] &= v 7 R v 7 A% A2 LT, W
DD sysloghr— "B E T LIEGAEIZTXTO NT 7 4 v 7 ZHIRT 20 E 20 &fEE L E
T, TCP Z#HET 5 &, ASA [Lsyslog h—"DFEFEAMRHE L, EX=2 U7 s fR# L L TASA
ERET O LWEEAE 7 ey 7 LET, UDP #fET 5 &, ASA UL, syslog Hh— 323 Eh{E
LTWD2E D N BHRAe SHT LWL A FF AT LigE T £77, ARRA— MEZ, Ebbn7m
kAL TH 1025 ~ 65535 T9, 7 74/ O UDP AN— 514 TT, 77 4/b FD TCP A—
N3 1470 TY,

GE)  TCP TO syslog DiEfF1E, AX 2 /3A ASA TV HA—FENTWEHA,

D H15E~D EMBLEM 2R O syslog A v — P DERK
fth > Hi 715~ EMBLEM JE D syslog A vt — %A T 51213, RO FNEEAZFZITLET,

FIE

AT 71 [Configuration] > [Device Management] > [Logging] > [Logging Setup] % 3R L £ 7,
AT w72 [Send syslogs in EMBLEM format] = v 7 R v 7 A% A2 LET,

syslog H—/\DEREDEME - ITIRE
syslog H—/3FGE ZBINE 72 ITRE T DT, ROFIHEELFEITLET,

. axyy
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| a2y

ATy

ATy T2

ATv73
ATy T4

ATy T5

ATvT6

RER T /8y T 7D syslog * v E—CDEE .

FIE

syslog =" EDBEIMHEHT LA 2 —T7 A4 A%, Fay Xy URARNLIERLE
bé‘o
syslog F—"E DBEIZHEHTHIP 7 FLAZ A LET,

syslog %—/ 373 ASA F 721X ASASM &L OEFIZEMAT 571 b= (TCP £721X UDP) %%
WL EF, UDP £721L TCP DWT N0 Z A LT syslog v — N7 —# ZXET D5 L DI
ASAB I NASASMZRET HZ N TEET, v havzBELRWES, T 74/ D
~7'v s a/ux UDP T,

syslog —/ M2 T, ASA £721X ASASM & OlEICHEH IO AR — FESEZ AT LET,
[Log messages in Cisco EMBLEM format (UDP only)] = v 7 Ry 7 A& AL T, A 2D
EMBLEM A TA vt —V % m ZICiET o0 E I hEfELET (Fr has s LT UDP
PIBRINTWDGEICIRED) o

[Enable secure logging using SSL/TLS (TCP only)] &= v 7 /R v 7 A% A2 LT, syslog #—
DD SSL/TLS over TCP DAEHIZ L 0 R S 41, syslog A v B — Y ONERKE LI D
XolEELET,

[OK1%Z7 Vw7 LCHEZTT LET,

RAEO S /Ny T 7~D syslog * v —TDEE

ATy T

ATy T2

ATy T3

— IR ERAT YT & e DN 7 Xy 7 7 IZEE T 5 syslog A v B — VAR EET HLERH
DET, LA vE—IF, VA MORZIZEBMENET, Ny 7 7B XW otz b
T ODFIRY T T oTREAELIERE. ASAVWVSIEWNI o2y 7 7 B RIOBFTI R
TTHEIICHESNTVRVIREY , N2 v —VFAREINDIHLNA v =2k - T
FEEINET,

syslog A vE—UE2NEH a7 RNy 7 7ICEEFTHITIE, ROFIEEZFEITLET,

FIE

WONWTININDOAT > a rZIERL T, WER 7 Ny 7 7 IZEET 5 syslog A vE—V %
E]\/iﬂqo

* [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]
* [Configuration] > [Device Management] > [Logging] > [Logging Filters]

[Monitoring] > [Logging] > [Log Buffer] > [View] DJIAIZ#4R L £9°, KIZ [Log Buffer] 4 > T
[File] > [Clear Internal Log Buffer] DJEIZIEIN L T, AFa s Ny 77 2T LET,

[Configuration] > [Device Management] > [Logging] > [Logging Setup] DJIHIZER L T, HNE=
TNy T 7D A ZXeBEELET, 774N Oy 77 ¥4 XL 4KB TT,

REDYVE |
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B nsosvor0r59va~orn

ATvT4

ASATE, HTLWA v —UZF&HENE TNy 7 7IRIEL, WolXWilieozm 78y
T ONEENE 7T v a AEVIRGFELET, Ny 7 7 ONFEJIOBENSRITT 5 &
T, ASA X, RDFA LAX TR EHAT DA4RITR Y 7 7 A VEAERLET,

LOG-YYYY-MM-DD-HHMMSS . TXT

YYYY I, MMIZH . DD IZ AT, HHMMSS I3FE. 2. BL OB TRENZ-HEZ T,
BIDOBFHCH LWA v B —V 2R FETHICT. ROFT T a0 nhd 1 D EIRLET,

7T v va AEVITHLWA v =V ERETHITIE, [Flash) F=v 7Ry 7 A%
412 LT, [Configure Flash Usage] %7 V w2 L %79, [Configure Logging Flash Usage] %
ATaTRy 7 ANERENET,

1. BX TR T7 7y v a AEYORREELZ KB THELET,

2. OX LT HT Ty a A VIREET A/ NE X fE RS KB CHREL £,

3. [OK]%#27Uw 27 LT, ZOXATurlRy 7 2A2HLET,

«FTP H—NIZH LA v — TV ZE(ET 5HI2IE, [FTP Server] F= v 7 R v 7 A% A4 IZ

L. [Configure FTP Settings] 2 U 2 L%, [Configure FTP Settings] %1 7 1 77K v 7
ANERINET,

1. [Enable FTP Client] &= v 7 R v 7 A%+ N2 LET,

2. FIRSNIT 4=V RIZ, FTPH—RIPT RL A NA a—HF4 RAT—F&A
ALET,

3. SAV—REMGEL, [OKI &2V v/ LTIOFA TR Ky 7 2EHLET,

REOT Ny T 7DITSTv1a~DREE

&

ATy T2

ATvT3
ATvT4

WHe 7 Ny 775277 vy a AEVIRFET DI2E, ROFIEEZFATLET,

FIE

[File] > [Save Internal Log Buffer to Flash] OJIEIZFEIN L $ 5,
[Enter Log File Name] % A 7 12 7R v 7 ANMFRINET,

BPIDOA T a @R L, LOG-YYYY-MM-DD-hhmmss.txt TEXDF 7 /v b 7 7 A V4T
gy Ny 77 ERELET,

2EBBOA T arERIRL, Ol Ry 7707 7 ANVAERELET,
0y Ny Ty DTy ANGEATILTOK] %2V w7 LET,

. axyy
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nYORBTERTEEREIS v A TUnsRozE ||

AJDORBETHEATRELAT ISy 1 A EDERENER

ATv T
ATvT2
ATvT3
ATvT4

ATy TH

ATy T6
ATy 17

B ORLETHEMWRERATE Y 7 v v a A OFBELZEETDITE, ROFIHEZETLE
ﬁAO

FIE

[Configuration] > [Device Management] > [Logging] > [Logging Setup] Z 3R L £ 7,
[Enable Logging] 7= v 7 AR v 7 A% A NI LET,

[Logging to Internal Buffer] i} ™ [Save Buffer to Flash] = v 7 R v 7 X &4 12 LE T,
[Configure Flash Usage] #7 V v 7 L £7,

[Configure Logging Flash Usage] %A 7 2 7R v 7 ANRKRSINET,

A NMERATEDL 7T a2 AT DERKREES KB CTAALET,

T 74/ F T, ASAIE, W7 7 v v 2 AE VY ORKIMBEZ e 7 7 —X I TX £7,
ASA T V5 —H BRAFT DT OICME N7 7 v 2 AE ) Of/NEEREIL3IMB T
T, W77 v v a AEVIRGFSNTWDLEr T 77 A NMZED, W77 v 2 AEY OZE
ERENRESNTRADBOFREE THI->TLEIHA, ASAlTRb Ve 77 7 A L2 HIkR
L. HiLWwe 777> A VORGH b R/NROREPHEIND LI LET, HIRT L7 74
WIS FTTEWT 7 AV E TR THIBRL TH2EE XA Y OFEDF/NNROREEL T
B> TV DA, ASAIZZEDOH L\l 7 7 A VERIFTE EHA,

7Ty va AR VICRX T T HIOICHERT 522 S IO R/NEREZ KB TA LET,
[OK] %7 U w2 LC, [Configure Logging Flash Usage] # A 7 2 7R v 7 A% AL £7,

ASDM Java Console [C &k Bk Snf-To Y DSBEOE—

AT T1
ATvT2
ATvT3
ATv74

ASDM Java 2 Y — V&AL T, ASDM 7 —D T Ty a—T 4 VU TITHESL D, ok
SN RN ETHRAMEATERRBINaE—T&ET,

ASDM Java Console (27 7 £ A4 221X, ROFINEZETLET,

FIE

[Tools] > [ASDM Java Console] DJIEIZEIR L F 7,
aryY—=nATmEANLT, B~ DAE Y FEHEREF R LET,

Ay V= Tgl ANLT, IR=V aLrvarz2FTLET,

Windows # A7 <X — ¥ %%, asdm_launcherexe 7 7 { V& X7/ 7 Y v 7 LT, AE
VEEHELER L ET,

GE) AEVHEID Y TORKIEIX 256 MB T,

REDYVE |
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B =z 7Lz~ syslog # v —UitfE

BFA—IL T ELAAD syslog A v E—PMiEE
syslog A v =V EBEFA—L T FLAIGEET DI, ROFIEEZFEITLET,

FIE

AT 71 [Configuration] > [Device Management] > [Logging] > [E-mail Setup] % &R L 9,

ATV T2 BFA—IN A= L LTEEFEEIND syslog A vE—VDOEEFELT FLAE LTHAT S
WA=V T FLRAEEELET,

ATYF3 [Add] 27 V7 LT, FBE LTsyslog A v b=V OZEHEDEBEFA—NT RLAZANLE
D

ATV T8 ZOZEFEIEET D syslog A v E—VDEKEL~LE, Fay XX oy A RDLER
Liﬁ— SEAEDE A A —/ T R L CEH S5 syslog A v E—YOEKET 4 V4

VHRESNEERELALLLED A v —UREE S E T, [LoggingFilters] ~A > T

?‘éﬁéﬂf:ﬁ“ma/*‘ﬂ/ TANEL, FEFANAZEFICEH SNET,

RATY 75 [Edit|#7 Vv 7 LT, ZOZFEE~EET Hsyslog A v E—VOBEOEKREZELTLET,
ATv 76 [OK] %7 V27 LT, [Add E-mail Recipient] ¥4 7 2 7R 7 A% L £,

BEFA—ILZEEDEBMEITHSE
B A—NDOZEEBIOCEREZBMEITHET 2I121E, KOFIEEZFEITLET,

FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [E-mail Setup] % 3R L £,
25y F2 [Add] £7-1F [Edit] &7 U v 7 LC. [Add/Edit E-Mail Recipient] #' A 7 12 7 v 7 A% F7 L
D

ATV T3 EDETA—NT FLAZANL, FryZH T U A D syslog A ZER L £,
HRELVVVFRO L IICERSHLTOVET,

« Emergency (L1 0, ¥ 27 ADMEHAHE)
CH)  HEHEELVLO0ZERTLILEBE0TEEEA,

« Alert (L~ 1, BN AN 24 2E)

« Critical (L)L 2, 7 U T ¢ 1VEAE)

* Error (L3, =5 —5:4)

« Warning (L~UL 4, b2 f:)

* Notification (L~L 5, 1EH 72238 72 5:1F)

» Informational (L~UL 6, [EHA v EB—T D)

. axyy
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yxE—+ smrp —0EE

» Debugging (L-V 7, 77307 Ay —Y0h)

G  %HEEBFA—NT RLASNDRA =% T V2 Y 73 5851%, [Add/Edit
E-Mail Recipient] % A 7 1 77K v 7 ZATHE LIZEHKE & | [Logging Filters] ~A > T
TRTOEFA—NZEHIHLTRELL e — SV T g VX OBEREDS S, |
N D HPER S ET,
ATy 74 [OK] %27 V7 LT, [Add/Edit E-Mail Recipient] A 7 1 7R v 7 A% AT F7,
BINE7ZIMEE SN 7-=> kU A [E-mail Recipients] A NIFRINET,

ATV TS [Applyl 27 UV v/ L, BENEZRI T2 74 F2b—va VIR EFELET,

1JE— bk SMTP H—/\DBTE
BrEDANRY MCHTHEFA—N T T7— b BIOBADEERL DY F— F SMTP —
NEBFET DI, ROTFNEEZFITLET,

FIE

AT w71 [Configuration] > [Device Setup] > [Logging] > [SMTP] DJEIZ#EIN L F 9,
ATYT2 774U SMIPH—1"DIPT KL A& AN LET,

ATV T3 (LE) AZ L8 SMTPH—_"DIP7 RLZZ AN L., [Applyl &2 U v 2 LTERNEE
FEfrar 7 4 Falb—a VITREEFELET,

a2y —ILiR— bAD syslog A v E—TDEE
syslog A vE—U%a YV —)LiR— MIEET LT, ROFELZEITLET,

FIE

RTFYT1 ROVTNDLOFT v a v EBRLET,
* [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]

* [Configuration] > [Device Management] > [Logging] > [Logging Filters]
AT w72 [Logging Destination] 7 7 AT Y —/LZ&IR L, [Edit) 227V v 7 LET,
[Edit Logging Filters] # A 7 B 7R v 7 ANFRINET,

ATV T3 TRTCOARU N 7 TAEFFRFEDA XY b 7T ADNT DN syslog ZEIR LT, =
V=)V AR— MIEET D syslog A v E—VERELET,

nxyy
|
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B et ErassHty s 3 ~d syslog 4 v —UDikfE

Telnet £7/=(XSSH v > 3 U~ D syslog A v E—PDiEE

ATy T

ATy T2

ATvT3

ATy T4

ATy TH

syslog A v &—U % Telnet £721X SSH ¥ v ¥ g VITEETHITIE, ROFNEEZFEITLET,

FIE

KONWT DDA T > a v aBIRLET,
* [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]

* [Configuration] > [Device Management] > [Logging] > [Logging Filters]

[Logging Destination] %7 7 A @ [Telnet and SSH Sessions] Z&R L, [Edit| 227 U v 7 LET,
[Edit Logging Filters] % A 7 12 77K v 7 ANEKRSINET,

TRTOARY N T TRAEFNIFFEDA XU N 7T ADWNTINMND syslog 23R L T,
Telnet 721X SSH v > = VZHEET D syslog A v E—VEHFRELET,

[Configuration] > [Device Management] > [Logging] > [Logging Setup] DJIAIZEIN LT, BlED
tyvaronX R EAR—=TMILET,
[Enable logging] = v 7 R 7 A% A 2L, [Applyl &7 U v 27 LET,

=JL ==

syslog A v t— L DEETE

=JL =

syslog X v — U DETE

ATy T
ATy T2

ATvT3

ATvT4

syslog A v B —UZRET DT, WOFEEZFITLET,

FIE

[Configuration] > [Device Management] > [Logging] > [Syslog Setup] DJEIZER L £ 97,

T7ANAyE—VDOR—R L LTHEHT 5 syslogth— SOV A7 A v ZHEEZSINL £,
77 4V MX LOCAL(4)20 T9, Ziud, IFEALEDUNIX VAT ATHEL/RDa— KT
T, 721U Ry FU—7 FRYL A TIE8HD 7 7 U Ty N ENTVWA D, VAT
L7 TEIOEEZEELRTNIRO2WGEERH D £,

[Include timestamp in syslogs] = > 7 /R v 7 A& A A2 LT, 25 I D4 syslog A vtE—
W AA &AL £ 9,

27 A AT R LTS A I e o — 4 & syslog A v —UICRIRT 25G1E. [Hide
username if its validity cannot be determined] = v 7 AR > 7 A% A4 7IZLET, T 7 +/V Fi&iE
T, = —FAREN GG, TR E 2 ARG E, 2—FAIFIERRTT, &
ZIE, 2= RRS T2 —FLDORDVICASRAT— REAN LGS, fifke LTEREINS
syslog 2 v & —UC [2—H4 ) Z#BTONLETT, v /A ClTL NI T2 —T 4
YIRS T DI, B — P ERRTHIEHTEET,
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syslog ID 5% D fmsE .

AT w5 [SyslogID] 7 — 7 WMIFRKRT HIEMEZBINL 3, EHAARERA T > a U, kO LEBY T
TO

s [Syslog ID] 7— 7 /WZFXTD syslog A v&— ID ZHRKAR-T 25 L ITHET HITIE,
[Show all syslog IDs] Z i8R L £ 9,

* [Syslog ID] 7 — 7 WZH/RIZ T 4 B—T7 /W2 LTz syslog A v 22— ID 2 2 £RT 5
X9 ET 521X, [Show disabled syslog IDs] Z 341 L £ 9,

* [Syslog ID] 7—7 /WZT 7 4 /b MENOER SN EHKE A FTe syslog A »E—TID 72
JEERT DX IITHET HITiE. [Show syslog IDs with changed logging] % R L £,

* [Syslog ID] 7 — 7 WMIZERKENEF Iz syslog A v 22— ID & BHRIZT 4 2—7
MMZ STz syslog A v B —VID 2T Z2ERRT D KO ITHET 2I12IE. [Showsyslog IDs that
are disabled or with a changed logging level] %8R L £ 7,

AT 76 [SyslogID Setup] 7— 7 /WIZiE, EDOFENFIZHESNT, syslog A vE—T DY A MRER
ENFET, BETHEADOA v E—VIDERIIA vE—VIDOFHMAZRINL 9, BN L
AyE—VIDIL, TA4E—TNMCTHZEL, TOERELANNVEZETTLHI L HTEET,
UA MWD A »E—2 1D 2B INT 2581L. FOHHAOIEBHIZHT=2 ID 38R L,
Shift ¥ —Z L7 HEDOHIPFADOHRKZICHT-ZHID A2 27 Y v 7 LET,

RAT9 T syslog A v E—VICT A AIDPEEND L HIRET DA 1X. [Advanced] 7 V v 7 LE
R

syslog ID E% E D#wE
syslog A v B—VOREEZLLT HITIE, ROFIEZETLET,

N

GE)  [SyslogID(s)] 7 4 —/V FIZFEREHNTT, ZD 32 FoRENDHMEIL, [SyslogSetup] X1 1
&% [SyslogID] 7 —7 L CR SN M VICE D iREY £,

FIE

AT 71 [Disable Message(s)] = v 7 R v 7 A% A 42 LT, [SyslogID(s)] U A MZID BEREHNT
W5 syslog A vE—T % T =7 M LET,

AT w72 [SyslogID(s)] U A MIF/REND syslog A v =V IDICEEFETHA v E—VOEKEOT X
YT UV EBRLET, EREL-VVTROEIICERINTNET,

« Emergency (L~ 0, ¥ A7 ADMEHIAHE)
(GF)  HEHEEL-VLOEZMEMTLZ LTI TEEEA,

e Alert (L~ 1, BIRERHLAS M EE)

| REDYVE |
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B eMBLEM Rzt syslog # v £—TAD T34 R ID DA

» Critical (L~L20 27 U T ¢ IV GAF)

s Error (L~L 3, =5 —544)

e Warning (L~L 4, 8485 544)

* Notification (L~b 5, IEW AN 72 5:4F)

« Informational (L~ 6, fHE#HA v E—TDAH)

- Debugging (L-L 7, FAy 7 A vl—TJDR)

ATw 73 [OK] %2 U v LT [Edit Syslog ID Settings] ¥4 72 7R v 7 2 %H L %7,

JE EMBLEM #2 X D syslog A v £—O~ADT/NL X ID DHE A
T 3A A 1D %I EMBLEM JER.D syslog A v E—TIZEH DI, ROFNEZFEITLET,

FIE

AT 71 [Enable syslog device ID] 7= v 7 /R v 7 A% 412 LT, F EMBLEM FED syslog A vt —
VIRTET A AIDDPNEEND L IR ELET,
RATYT2 WONWTNNOFT v a v HBIRLT, EOLIRT A AID ZHEHTLI0EHRELET,

* ASA DR N4

A F =T =2 AIPT FLA
BIRLZZIP T RV RIZKHET HA v H—T oA A%, Ruy X0y U RHLER
L/iﬁ—o

I A T EFERT HEE 1L, [Inan ASA cluster, always use master’s IP address for the
selected interface] = v 7 Ry 7 A=A 2 LET,

« X
REF DA —PERLTIN AT LET,

e ASA VT AR

ATFw T3 [OK] %7 VU 27 LT, [Advanced Syslog Configuration] ZA 7 1 7R v 7 A% L £,

syslog * vE—CICAGEEZIZED S
syslog A v E—UIZHAFERFZ 2B HIT1E, ROFIEEFATLET,

. axyy
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syslog * v t—C DEME .

FIE

AT 71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DJIEIZiER L £,
AT w72 [Syslog ID Setup] #H1% T [Include timestamp in syslogs] = v 7 R~ 7 A% A2 LET,
ATY7T3 [Applyl 27 U v 7 LTEENREZRFELET,

syslog A v E— 2 DEE
FEE LT syslog A v —V%F 4 B—T T B2, ROFIEEETLET,

FIE
A7 w71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DJIFIZIEIRN L £ 9,
ARTYT2 T—=TNANET 48 —TNWIIT 5 syslog #R LT, [Edit) 227 Vv 7 LET,

[Edit Syslog ID Settings] %1 7 2 7R v 7 ANRERINET,

AT 73 [Disable messages] = v 7Ry 7 A&EA 2L, [OK] 227V w7 LET,

syslog * v E—CDEKRKEDESE
syslog A v =Y OERELZELT 521X, ROFIEELFETLET,

FIE

A7 w71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] DJIFIZEIR L £ 9,
AT9 T2 EREEZEHET D syslog 27— /VNHERIRLC, [Edit] 27V v 7 LET,

[Edit Syslog ID Settings] %4 7 2 7R v 7 ANRERINET,

AT w73 @Y EKE % [Logging Level] K v 7 X UARNPLEIRL, [OK]227 U v 7 LET,

AR N EED syslog * v E—DTOvY

AL A HEE TREE D syslog A v B —UNAERINRNE T HITE, RO FIAZE S
i—a‘o

FIE

A7 w71 [Configuration] > [Device Management] > [Logging] > [Syslog Settings] DJIHIZi&R L F 7,

nxyy
|



nxyy |
B eMBLEM B2t syslog # v £E—DISF A R ID BB

AT9 T2 T—TNDsysloglD #ER L, [Edit] 7 Vv 7 LET,
[Edit Syslog ID Settings] %1 7 &2 7R v 7 ANRFRINET,

RT9 T3 AZUNAIEE Tsyslog A v B—UBER SR K 127 5IZ1%, [Disable messages on standby
uit] F= v IRy I Ak A AT LET,
ATYTR [OK]EZZ7 Vw7 LT, ZOXATRITRy 7 A& LET,

JE EMBLEM 2 XD syslog A v E—UIZTNA A IDEEH S
734 A 1D % 3E EMBLEM JER.D syslog A v E—IZEH DT, RO FIEEZFEITLET,

FIE

AT v 71 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] > [Advanced] > [Advanced
Syslog Configuration] DJIEIZ SR L £ 5,

AT 72 [Enable syslog device ID] F= v 7 R v 7 A% AN LET,
AT v 73 [Device D] i} C. [Hostname], [Interface IP Address] & 7-1%[String] 47> a > RE %7V v
7 L/ i j—o

s [Interface IP Address] 47> a U ZIBIR LA, Fay7rHX o UARNTELWA
H—T oA APBIRINTNDZ 2R LET,

« [String] 473 3 v &38R L2841, [User-Defined ID] 7 4 —/L RIZF /34 A ID % AJ)
LET, XFHOE S, HKATI16 LFETT,

G AX—7 T 5HE, EMBLEM JEXD syslog A v &£—I<°SNMP k7 » 7127 /34
A IDIFFRRENET A,

ATy 74 [OK] %7 V27 LT, [Advanced Syslog Configuration] %A 7 1 77K v 7 A% AL £7,

DAZLARDY R )R MDERK
AN b VA MDERITIT. RO 3 HOOREELHEH L ET,
e ARXUKNITTRA
« HRE
« AvE—T1ID

BEORX 7O (SNMP — "7 8) IZKETEIAX LA N VR NEERT D
WX, RO FIEZFATLET,
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FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Event Lists] DJEIZER L £,
ATFwF2 [Add] %7 VU 27 LT, [AddEventList)| ¥4 7 /Ry 7 AFRrLET,
ATYT3 AN VAMNOARIEANLET, AR—RIMHTE A,

ATv T4 [Add] =7V v LT, [Add Class and SeverityFilter] # A 7 1 7R v 7 A% Fr L ET,

ATYTE Ky 7Eor VANNLARC N 7T AERBIRLET, BHTEXDA XU 7T A%, #
ALTWAT N, R E—RIZE-oTRZY £,

AT9T6 Fuy7Zor UZXMpLEREL NV EZBERLET, EREL-VLZIROLEY TT,
« Emergency (L~L 0, ¥ A7 A0 HAEE)
GF)  HEHEELVLOEZMMATLZ LTI TEEEA,

* Alert (L b1, BRI 4 22)
* Critical (L~L2, 7 UT o JVGf)
 Error (L~L 3, = F—5AF)
« Warning (L)L 4, B4540F)
« Notification (L)L 5, IEH 7EABE 2R 5:0F)
« Informational (L~L 6, fFH A v E—T D)
* Debugging (L-L 7, T/ 7 Ay —T D)
AFvF1 [0K] %7V »Z LT, [AddEventList] ¥ A 717Ky 7 A& L ET,

ATw 78 [Add] %7 VU 7 LT, [Add Syslog Message ID Filter] # A 7 2 7R v 7 AaFor LET,

ATYT9  TANFIZEDD syslog A v E—ID £/l syslog A v E&— 1D O#iFH (101001 ~ 199012
7mE) mANILET,

ATvF10 [OK]%27 VY vZ LT, [AddEventList] ¥4 7 /Ry 7 ZA%HAL £,
HEIDA X v Y R MIFRENET,

OX>Y 4L 2DEKE

AX T DBEANDAVvE—2 T4 I)LADEA
OX T DA = TN X EEATDHITIE. ROFIEEZETLET,
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FIE

AT w71 [Configuration] > [Device Management] > [Logging] > [Logging Filters] % &R L £,
RTYT2 T4NZEWMT 20X FOREOARTZERLES, BRTE 50X 7 O5u%kI3RD &
B TT,

« ASDM

e 1/ —)L 7R— b

cEwf AL

« NEBS > 7 7

e SNMP #—3

* Syslog #—~3

e Telnet £721XSSHE > v 3

ZDIFEMN, 2FEB DI Z A [Syslogs From All Event Classes] & 3 % H @ 75 7 A [Syslogs From
Specific Event Classes] C & #IREAEZITWET, 2FHON T LTI, ¥ 7D~
DAy =% T4 NE ) o TTHGEIMMEHT H2ERERA NS NI TARKRRIND
EN, TRTOAR RN I TR L TaFX U T 2T 48 —TMITHNEERT D&
HLTEET, 3BFBEHOI T AL, BIRLEEu X IO E~DA v E—V% 7 42
CITT LGB T AR N 7T ARFRRINET,

ATwF3 [Edit] #7 U 2 L, [Edit Logging Filters] ¥4 70 /R v 7 AeFrLET, 74 NVHX &
M. e, 23T 42— NCTLFIECONWTE, vX 7 74 VX OHH (26 X—
V) BERLTLIEE N,

AX>T 7452 DER
74 B EHRT BI0E, KROTFIEZETLET,

FIE

ATY T BERELLZESNTsyslog A v b= D7 4 V2 ) 2 7 %47 9846 1%. [Filter on severity]
FTva raRRLET,

ATY T2 A F JRANMIESNTsyslog A =YD 4 VH Y 2T 54T 451%, [Use event list]
F7varaRRLET,

RT9 T3 BRLISERICKTHr X 72T _CT 4 B—7 T 5541, [Disable logging from all
event classes] 47 > a VA BN L FT,

ATV T8 [Newl 227 Vw7 LT, HiLWAXR N VARZBEIMLET, 4 X2 URNEHZITEN
THFIEICONWTIL, BAZ L AR URXROER 24 =) ZZRLTIZEN,

. axyy



| axvy
syslog A v E—2 1D 7 4 L2 DEMEITHESE .

ATFYTS Fuv T VAN ARV N IV TRAZEIRLET, FHTXZAV N 7T 2%, fF
HALTWBT NN, A ET—RIZLoTEARY F7,

ATFYT6 Fay7EZy JRARNnS, aXod Avb—V0OBEKKEL~LEZERLET, BRELAN
JVIEIRD & B0 TY,

« Emergency (L~ 0, ¥ A7 AD0MEHIAHEE)
GH) HEELVL0ZHEMTD I L3EBOTEEEA,

 Alert (L~ 1, RIRFSEHAL 7S 24 )

» Critical (L~L20 7 UT ¢ 1 VEAF)

 Error (L~L 3, =T —54F)

s Warning (L~ 4, #2444

» Notification (L~/b 5, IEH72AN B 72 5:4F)

» Informational (L~ 6, fHF#HA v E—TDRH)

* Debugging (L-~/L 7, TNy 7 A yE—T D)

AT TT [Add) 227V v 7 LT, AXRVE ZTABLOEKRELLZBML, [OK]227 Y v 7 L%
j‘o

HATOaTRy I ADEEHIZIE, 74 VFICH L TERIRLIZe X 7 0sminFRrnInEd,

syslog A v E—2ID 7 4 LA DEMEITHRE
syslog A v = ID 7 4 V2 AR E T2 13 T2 FIAIZ DUV T, syslog ID i E Dt (
21 ~—=v) ZZRLTIIZEN,

A=V IVSREERET 4 ILEDEMFEITESE
A=V DT74NE ) TIHEHTDIEIA =T 7 T ABIOEKE LV EBINE 7213w
LT 2512E, ROFIEZFETLET,

FIE

ATFYT1 Fay7Z T VAMDBARV N 7T RAEERLET, FHTEXAANV N 7T 201%, ff
HALTWBET N, A E—RIZL-oTERY FT,

ATYT2 Fay 7o JRAInH, aX o7 Avb—VOBEKRELLEERLET, BERAELN
JVIFEIRD &80 TT,

e Emergency (L-UL 0, v A7 A0EHAAREER)
GE) HEEELNLVOZMENTLZLIIBHOTEEEA,
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B Lt ne 0y SRROTRTO syslog * v E—SDElE

ATvT3

* Alert (b 1 HIRERHALAI 4 82)

* Critical (L~L 20 7 U T ¢ IV 5fF)
 Error (L~L 3, =7 —54M)

» Warning (L)L 4, 45 541)

« Notification (L~L 5, TEH7EABEE R 50F)

« Informational (L~ 6, fHEHA v E—TDAH)

* Debugging (L7, TRy T A vb—TDH)

BB T LS, [OK] 227 U v 7 LET,

BELEEEADEADY SARADTRTD syslog »* v E—TDEE

ATy I
ATv T2

ATvT3

syslog A vtz —

7 5 ANDTRTDsyslog A v — P &HE LIz HAEICEET 2101, kOFIEEZETLE
R

FIE

[Configuration] > [Device Management] > [Logging] > [Logging Filters] %2R L £ 9,
BELEHNEOREE A —/"—F 4 FT5121%, BETHHEEZERRL TH D [Edit]) 7
Uy 7 LET,

[Edit Logging Filters] %4 A 7 2 7R v 7 ANFRINET,

[Syslogs from All Event Classes] & 7213 [Syslogs from Specific Event Classes] fE Ik D 410> Ta%
EEELL, [OK]Z7 Vv 7 LCZDEATul Ry 7 AL ET,

2Ez2iE, ERETOA v E—UPRHE S Ny 77 I0EESNDEHICHEEL, ERE3ID
haZ FADA v E—URNE e 7 RNy 7 7 I GEESNDIXHIEETHE, oar 7 X
L—Ya VMBS ET,

1 2oD7 FAPEEOH T RIGEEEIND LHIHETIHAIE., kI Licikirs 7 o1
B2V F g rEEIRLET,

DOERL— FDOHIR

syslog A v E—V DR L — NEHIRT 2 120E, WOFIEEZFEITLET,

. axyy



| a2y

ATy

B D syslog * v t—Ii T 5 L— rIROR Y 4 TE-EZE [

FIE

[Configuration] > [Device Management] > [Logging] > [Rate Limit] % 38R L £,

ATYy7T2 L= MlRZEV L TLErFL T LL (X yE—VOEKRE) 28RLES, ERE L

IFRO IS ITEFRSNTWET,
« Emergency (L~L 0, ¥ A7 A0MEHIAHEE)
o« Alert (L)L 1, RIREGHALAN 4 2E)
« Critical (L2, 7 VT ¢ JVSA4)
« Error (L~UL 3, =7 —544)
« Warning (L~UL 4, #i200k)
* Notification (L/L 5, IEH7E03NHZE 70 5e4F)
« Informational (L~ 6, fHHA v E—TDR)

* Debugging (Lb 7, 730 7 Ay —YD%)

ATY T3 BEEIND A =D [No of Messages] 7 4 —/V RIZERENFET, /-, #RLEZE

ATvT4

¥ LNV THEETED Ay E— yﬁ%ﬂ@?é%@%ﬁ&ﬁéﬁﬁ%%(@%ﬁ)ﬁ

[Interval (Seconds)] 7 4 —/V RIZE/RSNET, T—7 06T 7 LoyLZRIR L, [Edit]

%7 1 w2 L C [Edit Rate Limit for Syslog Logging Level] AT TRy 7 AR LET,

PIBED FNEIZ DN TIE, fH % O syslog A »E—1Zxtd 5 L— MHROEI D Y4 TEIFELH
(29 ~—=2) ZZML TS,

B2Dsyslog A v E—2IZxdT HL— MIRDEIY B TFEEITIER

ATvT1

ATy T2

ATvT3

ATy T4

ffl 2 D syslog A v tE—IIZL— MRZFI VY TH, F72EFA -V T &I — MilllREZE
BT 521, ROTFIEEZFATLET,

FIE

FEE D syslog A v E—I2L— MlRZEID 4 TH8E1E, [Add] %22 U » 27 LT, [AddRate
Limit for Syslog Message] # 4 7 B 7Ry 7 AR LET,

LIBEDFNEIZ DWW T, syslog A v E— 106 2 b— MEBROBINE 72 135RE 30_—)
EHBL TSN,

FEED syslog A v EB—UIZkT 5 L— MlRZZ LT 5551%, [Bdit) 22 Y » 7 LT, [Edit
Rate Limit for Syslog Message] % A 7 & 778 v 7 A & KR Li‘j—o

LIBEDFNEIZ DWW TR, syslog RIS 5 L— MABROMRE (30 ~—) 2L TL
TZE,

REDYVE |



nxyy |
B osistos 5 v b—SicnT B L— rEIBDEME - HRE

syslog A v t—I2xt3 5 L— FHEIBRDEME-ILHE

FEE D syslog A v B— 2% 35 L— MHlBRZBIMEZIZEF T HI21E,. ROFEEFITLE
7

FIE

RAT9T1 FFED syslog A vE—TIZktd 5 L— MlIRZBINT 2841%, [Add) %27 U v 27 LT, [Add
Rate Limit for Syslog Message] % {4 7 2 7 7R v 7 A % KR LiT FFIE D syslog A vt — Tkt
T 5 L— MillRZZHE 3 535A1%, [Edit] #2 Y v~ LT, [Edit Rate Limit for Syslog Message]
HATOaTRy 7 AERRLET,

AT T2 L—bEHIRT D syslog A v E—TDID #ALLET,

RATv T3 HELERHENICEECTEDA v =V ORKREEATILET,

AT T8 FFELIEA =T — MEHIRT 2RO HNE L 7o 2 REHIEIE 2 AP AL CA T L, [OK] &
70y LET,

GE) A vbB—THEHIRZ: LIZT 53546 1%. [Number of Messages] 7 -« — /b R3 L OY [Time
Interval] 7 4 —/V K& L HIZT T 7 DEFIZLET,

syslog EXEIZxT % L— hRIRDIRSE
$ L7 syslog EAIED L— MR ZZES 51213, KOFIEZFAT L £,

FIE

ATV TN FHELEERETHEWRERA vt —VORKEEHELET,
ATV T2 fHEELZEKEDA vy E—IICxt3 5 L— b &HIBRT 2 5L L 70 2 R IR 2 B BAL TA D)
L. [OK]ZZ7 Vw7 LET,

BRI A Yy E—VEHRENFRINET,

G A vE—UHEHIRL LICT 555 1%. [Number of Messages] 7 4 —/L K35 L U [Time
Interval] 7 4 —/V RE L HIZT T 7 DFEFICLET,

OJDE=41)25
RX T AT —=Z ADERIZON T, kOa~vr FEZRLTIEIN,
* [Monitoring] > [Logging| > [Log Buffer] > [View]
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O Ea—7#ERALIsyslog * v E—SD T2 Y DY .

ZORA TR, v Ny 77 2RRTEET,

* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
ZORL TR, VTNV EA bOR T ERRFTEET,

* [Tools] > [Command Line Interface]

TORAUTIE, SESERFEAHTIT 4T a~r FERITL, REERTHZE
NTEFET,

O Ea—7%ZFERALEsyslog A v tE—SDT7 052U V5

Real-Time Log Viewer 33 & O' Log Buffer Viewer OfLE DO H 7 AMZxIET 25 1 DL EOfEIZ IS
W, syslog A vE—=T%7 40 Z ) T TEET,

B Ea—TONWT N L Tsyslog A vE—V%7 4 VY 735121, ROFIE
ERITLET,

ATy T

ATy T2

ATvT3

FIE

WONTNIDOA T a v BRIN L FE T,

* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
* [Monitoring] > [Logging| > [Log Buffer] > [View]

[Real-Time Log Viewer] & 7213 [Log Buffer Viewer] ¥ 4 7 2 7 7R v 7 ADWT T, V—/b
X—@ [Build Filter] 227 U v 7 L %7,

[Build Filter] # A 7 2 77K v 7 AT, syslog A ve— T D7 4 V2V v FHEMELIEE
LE7,

a)

b)

<)

[Date and Time] Sk T, U 7 /v% A A, FEERZ], FEEEPHDO 3 >OAF 7 a b 12
ZIERLET, FERAEZER LG EE, BEZADNLTRry 77X T U R DB
FIDEBIRL, B ZEE L ET, RFMEPH 2 =R L7254, [Start Time] 7 4 —/LV R
DRay X RKiE7 V7 T5E, DL X—RERENET, RnyrZoy
A R B E & AR 2N L, [OK]Z 2V v 27 LE7, [EndTime] 7 4 —/L KD R
OBy IHE T RANEZ ) I THE L UX—RERENET, Rry X HX T XL
MHIETHERTRAZEIRL, [OK] 227U v 7 LET,

[Severity] 7 4 —/V RICARN R EREZ AN LET, £72iE, [Severity] 7 4 —/v KOL
T[Edit) 7TA 227 Vv LET, F4NVEFV U TTHEREZVARNTCZY 7 LE
T, BEREI~TZ2E50520F, [AlZ27 V27 LET, [OK]ZZ7 Vv 7 LT, b
DFXFE % [Build Filter] # A4 717 ARy 7 AZF R LET, HHTHIELWANERIZET
BRI TEHIC W IR, [Severity] 7 4 —/v ROLRNZH D [Infol TA 2> %27V w7 L
e

[Syslog ID] 7 ¢ — /b RIZA %72 syslogID # AJJ L EF, F72lE, [SyslogID] 7 4 —/L KD
HROEAi) T A2 %227y 27 LET, Fay X URARNDL T 4V EMEOFM
ZIEIRL, [Add]Z#7 Vv 27 LET, [OK]Z727 U v 7 LT, 215D E% [Build Filter]
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. N Ea—7#@ERALfzsyslog A v E—CD T4 L2125

d)

e)

2)

h)

. axyy

BAT IRy 7 AR RLET, AT 2ELWANBRICET 258 FRICONT
%, [SyslogID] 7 ¢ —/L K OA41{AN %5Uﬁﬂ74:/%7)/7biﬁo

[Source IP Address] 7 4 —/V RICHZREEILIP T KL A% A9 57>, F 7213 [Source IP
Address] 7 4 —/V ROAMITI[Edit) 74 2> %227 Vv 7 LET, H—DIPT FLAEX
m?%vxw%mwal%%mujmm%ﬁj/ﬁbifo%m@m?%vxitim
7 RL A @%ﬁ.%[‘?%?—é ZiX. [Do notinclude (exclude) this address or range] = v 7 7R »
J AT mm%a)/ab [Build Filter] A 7 2 77K v 7 A2 25 D% E
ERALET, fﬁﬂ%?éf’: LWANERICE T 23 72 i #IZ DV T, [Source IP Address]
T A=)V ROEMNZH D [Info] TA 2% Uy LET,

[Source Port] 7 4 — /b RIZH 72 EELAR— R & A3 50>, £7213 [Source Port] 7 1 —
VROLEBO[Edi) 7 A 2% 27 v LES, Fry T XU YR RNRLT 4 VIS
DEMZZEIRL, [Add] 227V v 27 LET, [OK]ZZ VY v 7 LT, ZHHDFRE% [Build
Filter] ¥4 70 7R » 7 ZIZFR LE T, AT HIELWANIERICE T 23R FHIC
DUV, [Source Port] 7 4 —/V ROEMNZH D [Infol T A 2% 27 Vv LET,
[Destination IP Address] 7 « —/V RIZHE N385 1P 7 KLV A% AJ19 57>, F 721 [Destination
IP Address] 7 4 —/V ROAMIT[Edit) 7 A 2> %227 Vv 7 LET, B—DIPT NV RAER
ILIP 7 R ADOREDHEIPHZIEIRL, [Add| 227 Vv 27 LET, FFEDIPT RLAETIX
IP 7 R L ADO&iH % BRI 5121%, [Do not include (exclude) this address or range] 7= » 7
Ry 2% A Az LET, [OK] %27 U v 7 LT, ZiLbORE % [Build Filter] %4 7 1 7
Ry 7 AFRRLUET, HHTHELWANERUCEET 23 72 RIZ DWW T, [Destination
IP Address] 7 4 —/V ROFHNZH 5 [Info]l TA 2% 27 U v 7 LET,

[Destination Port] 7 «t —/V RIZH RN 250568 — h & A9 575>, F721% [Destination Port]
T4V ROABIOD [Edit] 7 A 2% 7 V7 LET, Ray XXy URXARNRLT 4V
ARBOFRMERIRL, [Add] %227V vy 7 LET, [OK]Z2 Y v 7 LT, ZRHOREL
[Build Filter] A 7 2 7R v 7 ZIZRK R LET, BHT2ELWANERUICET 255/ 7
THHIZT OV TCIL, [Destination Port] 7 4 —/V ROEMNZH D [Info] T A 2> %27 Vv LE
7

[Description] 7 £ —/V NIZT A NVEZ VT THFANEANLET, ZOTF A MIE, E
HERBLZGT, | DU EOXTFNOREEOXTFIERRETEET, L, EIlan
VNIE LT TEDH Y FHA, Fo. ZORETIERLFE/NDXFRRBIENET, &
Box N ERRETHHEIE. By~ TR 7,

[OK]ZZ7 Vw7 LT, 8E L7 4 NVZ ) VIR EEB Y Ea—7T O [FilterBy] K v~
Zyr YA MIBMLET, 7402 CFFNIREDIEAUITENES, FILTER: 7L 7 1 v
7 A%, [FilterBy] Fr >y 77X 02 URAMIERREINDTRXTONAZL T A NVEERL
iTo_®74—w% ET7 o LRTHIFANEANT L TEET,

ROFIZ, FEHENL OB ZRLET,

Build Filter (15 T4 IILEXFIHRR
Source IP=192.168.1.1 £7-1% 0.0.0.0 FILTER: srcIP=192.168.1.1,0.0.0.0;srcPort=67;

Source Port = 67

Severity = Informational FILTER: sev=6;dstIP=1.1.1.1-1.1.1.10;

Destination IP=1.1.1.1 ~ 1.1.1.10
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Build Filter D51 7 4 LA XFFIR

725001 ~ 725003 OHEPHFL D syslog ID FILTER: sysID=!725001-725003;

Source IP=1.1.1.1 FILTER: srcIP=1.1.1.1;descr=Built outbound
Description = Built outbound

ATY 74 [FilterBy] R vy 7 X U YA NDHEED | DEERL, Y —L3—O [Filter] 7 Y v 7 L
T, syslog AvtE—T&% 74 NVEZ V7 LET, ZOFKEIE, TNLEDOTXTO syslog A v
—ViIcb#EHINET, TRXTOT7 4 VE %27 VT T HITIE, Y —3—{Z& 5 [Show All]
27y LET,

(G¥)  [BuildFilter] ¥4 7 a0 /Ry 7 A& AL THRE L7 4 VX IIRGFETCEEHA, 2
NoDT7 4 NEIX, EDT 4 VEBER SV ASDM E vy v a Y ORTHHTT,

T4 B ) VTEREDRE

[Build Filter] # A 7 0 7R 7 ZZAEM LR LT 7 4 VB2 ) & TRREZRET D121, K
DFNEEFATLET,

FIE

RONWTNINDOA T a 2R L ET,
o [Filter By] Koy 7% VA RNTELEEZ AL T, 74 NMXEEBEEELET,

e [FilterBy] K2 7*# > YR NTT 4L # %2R L, [BuildFilter] #7 U v~ 27 LT [Build
Filter] ¥ A 71 /R 7 A% FK/RLEJ, [ClearFilter] #7 U v 27 LT, BHEDT 4 N H i
EXHIBRL, FTLWEZ A LET, ZRUNAOGEIL, RSNTCRELZZEE L T[OK]
27 Vw7 LET,

GE) b7 4n0F Y 7 ER, [BuildFilter] #4707 Ry 7 A TERZS N
T ANEDOIHZHA I NET,

V=N N—=D [Show Alll 27 Vv 73D L, TZ4NZ ) ZEIEL, 3T syslog
AvE—UNRERRINET,

O Ea—7ZFEALEFENDITY FOHET

Wi or 7 va—7 Z#H LT, ping, traceroute, whois, 35X O'dnslookup =~ K%
FITTETET,

REDYVE |



nxyy |
B cxvome

INbDa~Yy FROWFNPZFITT 5123, ROFMEEZFTLET,

FIE

ATV T RONTNDLDOFT > a B8R LET,
* [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]
* [Monitoring] > [Logging] > [Log Buffer| > [View]
AT 72 [Real-Time Log Viewer] % 7-1% [Log Buffer] ~31 >/ 5 [Tools] 7 V v 7 L, FEfr+ba~wyr

REBIRLET, 7003, BREINTE/FEDsyslogA vt—TV %27 Vv 7 LTary7xA b
Ama—uRKRrL, FTT0a~vr FE@ERLET,

[Entering command] % A 7 2 7R > 7 ZAMFR I, BIRL7za~y ROAHBIZ Fe v 74
vy URAMIERINET,

AT9 T3 BR LT syslog A vE—TDREEFEITLIP T RUAEIFLEEIP 7 KL ADWT i) % [Address]
T4 —IVRIZANIL, [GolxZ7 Vv 7 LET,

JBEL-fEkKca~ FEAORRRENE T,

ATV 74 [Clear] 7V v 7 LTHAZEHIBRL, FTT200a~vr KeRkay 72Ty JR b
RLET, MDEIDGLUTAT v 73 2#0IRLET, T L6 [Closel 27V v 7 LET,

OX > DER

R3:0xX 5 DERE

TI39bTr—L))—R BL)]

iy

HERE
Logging 7.0(1) SFEIFMIEERE L TASAR Y
N —2 mk o JiERA R L T,
By 77 ANERRLUTRIFET o4
TarbEENLTWVET,
WOBEMEAZEANSILE LT,
[Configuration] > [Device Management] >
[Logging] > [Logging Setup],

L— il R 7.0(4) syslog A v E—UNERENLDL— b
Z iR L £

ROWHPEE S NE LT,
[Configuration] > [Device Management] >
[Logging] > [Rate Limit],
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nxvroE [

HaE

iy

IS5y kTA—bY—R

B

a¥xXo 7 JA L

7.2(1)

SFEIERAE (nX T Lr A
RN TA BLOA vyE—VID)
TAYyE—VEBET IO =
v v RCfEHsaeX 7 VA N E
ERR L £,

ROBHENPELESNE LT,
[Configuration] > [Device Management] >
[Logging] > [Event Lists],

X7 ax s

8.0(2)

VE—h 0¥ 7 RAMORERHIZ
SSL/TLS M3 2 L 5 ICHEEL £

T, TOF T a vt BRENLET
2 N3V TCP DA AR T
7

ROBHENPELESNE LT,
[Configuration] > [Device Management] >
[Logging] > [Syslog Server],

a¥xXory J7I A

8.0(4). 8.1(1)

X J AvyE—T0 ipaa A X2 b
7T AKT o AR— FasBINE N E
L7z,

ROWHENPEL S NE LT,
[Configuration] > [Device Management] >
[Logging] > [Logging Filters],

aX T IALREINTZeX T
Ny T 7

8.2(1)

aX T AyE—VO dap A2 b
7 7 AT H AR — MBS E
L7z,
Rfrsnlcax o7 Ny 7y
(ASDM, Wi, FTP, BL U7 7 v
o) 27 VT T LEMYR— R,
WOBEEAZEE SIVE LT,
[Configuration] > [Device Management] >
[Logging] > [Logging Setup],

INAT — RO Ak

8.3(1)

SAY = FORBALICH T2 4 H— b
AEMENE LT,

ny va—7

8.3(1)

EETIPT RLAB LSS IP T R
AR Ba—TIIZBMNENEL
776

REDYVE |
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TS5y R Th—bY—R

B

1N I A 73 S A =

8.3(2)

TCP Z M3 % X 9 T syslog — 3%
BET D L, syslog P —"EFHTE
RONEE L ASA T — SR OME A AT
HEIZ72 B & Tsyslog A vE— T %A,
TOHH LA 7 ey LET (2
21X, VPN, 77 AT 74—,
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[Configuration] > [Device
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